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Welcome to...

              SurveyEdit              SurveyEdit
                        v1.0
  (it is recommended that you print this manual and keep it in a conveinent place)

          SurveyEdit v1.0 was created by Allan Wellenstein and Adam Glass, both of Master Software.
               Master Software is a Massachusetts based software company committed to high quality
                                        software programs for Macintosh users. © 1988
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    I'll start out by saying that SurveyEdit (along with MenuEdit) may be one of your most vital 
editor programs.  SurveyEdit lets you write survey files for Red Ryder Host 1.4 and up.  
These surveys can be written so quickly and easily, that you'll save countless hours.  No 
longer has writing surveys been a task!  Now anyone, even with little or NO PROGRAMMING 
EXPERIENCE, can use this program to create complex surveys.
    I used to be a little scared and apprehensive of writing a survey.  It might not work, and I 
would have wasted so much valuable time.  But now, writing surveys is a joy.  SurveyEdit 
handles branching, text files, large screen monitors, full screen text, and much, much more.  
I'm sure you'll soon decide it's an invaluable tool for survey creation.  However, with all this 
power comes a little bit of difficulty.  The program is a little confusing, even with the wonderful 
Mac Interface.  This difficulty will be easily overcome, as long as you read and understand 
the manual.  This manual is written in a simple and friendly fashion.
    Note well!  This program is not free.  Yes, this is the usual shareware pitch.  I don't 
expect all of you Host Sysops to be responsible enough to pay, but I must insist that 
you do.  You may use this program for three weeks.  After that three week period, you 
must either send in the Shareware fee, or delete ALL copies you own.  The fee is a 
modest $5.  You should send it (checks are preferred) to:

                                       Master Software
                                       c/o Adam Glass
                                       P.O. Box 151
                                       Waban, MA 02168

All checks should be made out to Adam Glass. Thank you.
  This is to promote further "Host-Aides".  We at Master Software are currently working on a 
new version of SurveyEdit, letting the user double-click on the lines and call up an edit box 
for that command.  Also, we are working on three more Host related programs.  Two online 
games and an online Host-Sysop program.  This will let you modify user's calling from 
locations, times on, preferences, passwords and all the other information in the userlog.  It 
will also let you edit text files, delete files, get  and change file information, delete files, 
change CONFIG preferences, and much more.  However, without further funding from the 
Sysop community, we will be unable to continue these projects.  We need your help - without 
it, these revolutionary "Host-Aides" will never be released, and you will lose out in the long 
run. Please support us by sending in the token fee of five dollars.
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    Now that I've gotten that out of the way, let's get on the good stuff.  For your convenience, 
the first page of documentation will start on the next page.  This is for those of you who 
choose not to include these "General Info" pages in your manual.
    Starting with the File menu, I'll go through all the menus, command by command, making 
sure you understand each.  The only exception will be the Commands menu.  You will get 
only basic help here, to understand this completely you must at least read the documentation 
on Survey Files in the Red Ryder Host manual.  If you have not already, please read Red 
Ryder Host's Survey Files Documentation before you read any more of this manual! 
This will make it much easier on both of us!!

(On to the Manual...)
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The File menu has all the standard options usually found in Mac programs.  Let's talk about 
the individual commands now:

New - This lets you create a new survey.  Survey Edit does not check for           free disk 
space and disks not present.  Therefore you should be very            careful when saving files 
to make sure everything is correct.  If you do         not do this, you could lose a lot of 
information!
Open... - This command lets you open existing SurveyEdit surveys.  Note:           trying to 
open a non-SurveyEdit survey will result in an error.                      SurveyEdit lets you edit 
existing surveys, as well as add more                       commands to the end of old ones.  This 
is where SurveyEdit really is             "head-and shoulders" above any other existing Survey 
File Makers. This       is why we called it SurveyEdit, and not SurveyMaker or SurveyCreator.
Close - This lets you close an opened survey file.  If you've made changes
    since the last save, SurveyEdit will ask you if you would like to save it          before closing. 
You may also click in the "go-away" box in the main              window as a shortcut for closing.
Delete... - This lets you delete a text file (survey).  For your convenience,          SurveyEdit 
makes you confirm deletions so you don't accidentally delete       an important file.  This is 
useful for deleting old versions of a survey to        keep your "desktop" free and uncluttered.
Save - This command lets you save your surveys to a disk. If you have not        saved your 
survey previous to selecting this command, you will be
    prompted for a name to save it as.  If you save your survey with a                name that 
already exists, you will be asked if you want to write over            the old file. Unless you're 
sure about this, just pick a unique name.
Save As... - This command lets you specify a new place (path) to save your 
    survey. It then saves your survey with that new name.
Print... - This command prints your survey on a printer.  You may use the          Chooser DA to 
select the printer driver you want.  Print asks you if you        would like to print a survey 
summary, exactly as you see it on the
     screen, or the actual survey that Red Ryder Host reads.
Quit - Quit simply returns you to the Finder. If you haven't saved after the
     last change, SurveyEdit will ask you if you want to.
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Undo - Lets you cancel the last action. If you select this again, it re-does
    the action you just erased with undo. Some commands (such as FULL
    PAGE TEXT and IMPORT TEXT) cannot be undone. Be very careful when
    you do this, as you will not be able to undo these commands.
Replace command... - This command prompts you for a command to fix,
    and then lets you fix that command.  You can't type in a number greater       than the 
amount of commands, and you can't type in an number less             than one.  You can't 
replace a one line command with an IMPORT TEXT
    or FULL PAGE TEXT command.  You must replace single line things with        other single 
line things.  Replace prints "replace" where you have
    selected to replace. The next command you make will replace the
    command number that now reads "-=> REPLACE <=-".  To cancel the
    replace command, simply select Undo from this menu (the Edit menu).
Insert command... - Lets you stick in a command you may have forgotten. 
    Insert asks you for a command to insert before. Like replace, you can't         do an 
IMPORT TEXT or FULL PAGE TEXT command in Insert.  You'll have       to insert one line at 
a time.  Also, insert is not undo-able.  Insert prints         the word insert on the screen. Then, 
to add in your command, you select       replace and replace the number SurveyEdit just 
created (next to
    "-=> Insert <=-").
Delete command... - This command lets you delete a line you entered.
    Delete command prompts you for a command to delete.  You can't delete       a 
nonexistant command.

All the commands (and brief descriptions) are listed in this menu.  For information on exactly 
what these commands are, please read page 54 of the Red Ryder Host Manual.  This will 
also help you to understand what our program is really doing for you.
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Add a Space - Lets you add a blank line of text for spacing out the survey's
    output.  Not as much of a trick as an often used feature.
Skip a Number - Lets you leave a space in your survey for a command you  
    may decide to put in later.
Enter a String & Last Input to Scratch - This is an often used feature.
    Very often when you write something to the scratch file, you want to            add a text line 
explaining what the following text is.  So you tell the              program what this data is (the 
string of text) and it'll write the text and        the last input to the scratch file. It ends up looking 
like this in the                 responses file:
                                  Entered string          Last input
                       HOME PHONE:          617-964-6866
                       WORK PHONE:          617-964-6088

    (For more experienced survey makers, all this command does is a
    Command #13 and a Command #5, in that order.)
Full Page Text - Lets you enter a lot of text at once, much like a text editor
    would.  Actually, what you have here is some editable text fields.
    Returns are allowed, so to save what you've typed in, you have to
    click "done", rather than just hit return. After you click "done", the text
    is printed on the screen and entered into the survey.
Import Text - Import Text is a simple but powerful command. It lets you
    import a TEXT file into survey text commands.  This is useful for                   converting a 
system bulletin into a survey file.  There may or may not          be a wait depending on how 
long the imported file is.
Insert Length-Bar - Is a feature not utilized in this version of SurveyEdit.
    However, in future versions, it will insert a length bar, which is useful          for long inputs.  
Length-Bars, for those who aren't sure, have nothing to        do with the "singles scene".  
They are, in fact, ruler type text lines that          show users how much space they have for 
their input.
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    The Info menu shows you information about your survey and your system. If the current 
file is not saved, the Info menu will say that the survey is not saved, and thus, there is no 
path.  The Info menu will also show you how many commands are remaining and how much 
memory is reserved for SurveyEdit.

    Now that we're done with the documentation, we'll go through making a sample survey 
that will help you to understand how SurveyEdit works.
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For simplicity (and time comparison) we'll make a survey similar to the one on pages 54-55 in 
the Red Ryder Host Documentation on survey files. The example will assume you have 
already launched SurveyEdit, and it has completely loaded.
___________________________________________________________________
Wait for the info box to appear at the bottom of your display screen.
Select "New" from the "File" menu, and an empty main window will appear.

•1• Let's start by giving our survey a title.  Select Command#1 (Display text line) under the 
command menu.  Type "New User Survey" in the Edit box.  Now move your mouse to before 
the text you just typed in and click the button.  Now add spaces until it is centered in the 
middle of the box and press the Done button.
                   •You will see your text appear on the screen•  
•2• Ok, let's add a space before we go on.  Select Add a Space in the Tricks menu.
   • -=> Space <=- will appear on your screen under the first command•
•3• Now let's continue with our survey.  Let's take this time to explain how to use the survey.  
We could write the text in line by line using command #1.  But, let's see if we can't speed this 
up with a "Trick".   Let's write the text we want and save it as a text file.  (You can use 
MacWrite and save your file as a text file or you can use text editing DAs like RedWriter.)  We 
have already made the text file that we will be using now.  Select Import Text from the 
Tricks menu and open the file named "Instructions.TXT".  
              -The text in the file instantly comes to your screen.-
•4• Let's ask the user some questions now.  Select command # 9 (Get input from user) in 
the Commands menu.  When prompted for the text, write "Enter your FIRST name: ", (notice 
the space following the colon). Press the OK button.  When prompted for the length to allow 
for, enter 15 and press the Done Button.
             -You will see your text followed by "15" in parentheses-
•5• Now we have to check if they entered something or if they just pressed the carriage 
return.  Select Command #4 (If empty branch to...) under the Commands menu.  When 
prompted for the number to branch to enter the number to the left of the question you just 
asked.  In this case the number should be "9". 

•6• We know they entered something, so now let's save it.  Before we write the information to 
the scrap file, let's write a string identifying it first.  We could do this by using Command #13 
(String to Scratch W/O C/R) and then Command #5 (Write last input to scratch) both 
under the Commands menu.  We will take a short cut with one more command from the 
Trick menu.  Select Enter string and last input and when prompted for the string, type a 
text line referring to the last input.  In this case we will write "FIRST NAME: " (note trailing 
space again).
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  -you will see  text to scratch and last input to scratch on your screen-

•7• Repeat steps 4, 5 and 6 with the following questions:
        "Enter your LAST name: " (with a length of 20)
        "Enter your phone number (XXX) XXX-XXXX: "(15)
        "What is the best time to call: "(30)
        "Enter your age: "(3)
        And observe spacing exactly as printed here.
•8• Add a space - like in step 2
•9• Now let's see if he/she entered every thing correctly.  Ask "Have you entered all the 
questions correctly? " by using Command #10 (Get Y or N input from user) You will not be 
asked to enter a length.  It is automatically 1.
•10• Now check to see if the answer was left blank - repeat step 5
•11• If the answer is "y" then we will skip (Branch) to line number 35 (This is skipping one 
number to start the survey over-because the answer would have been "n")
•12• He/She did not enter the info correctly so let's start the survey over.  Use Command #8 
(Start over) in the Commands menu.
•13• After you write to the responses file, the user is returned to the BBS after it.  So you 
must do everything like saying thank you before you write to the reponses.  In the surveys 
you write, please be nice to the people who spent hours of potential homework time writing 
SurveyEdit. Select Add a Space from the Tricks menu.  Now Select Command #1 (Display 
Text Line) from the Commands menu, type in "This survey was written with Survey Edit, by 
Master Software." and press the Done button.
•14• He/She did answer the questions correctly so let's save the information to the responses 
file.  Select Command #6 from the Command menu.  Now the user is returned to the BBS.  

      Save your work frequently!
       (Or use a desk accessory similar to Saviour, available on better BBSs around the country!)
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Special thanks to all the people who helped us out, including:
Curt Morrison ("Newton's Corner BBS" (617) 964-6088)
David L'heureux ("MacEast BBS" (617) 776-8722)
(Bug testing),
as well as Cider, Tasso, Tiger and Tony (our pets).

       Love and peace to Mac users everywhere!

                                 Allan Wellenstein
                                     Adam Glass

(Support available on the Boardwalk BBS, (617) 964-6866, located in Newton, a suburb of Boston, MA)
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